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1 About ICS213mm
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1.2

Introduction

This guide will introduce you to Outpost’s ICS 213 program and describe how to
create ICS messages that interact with the Outpost Packet Message Manager
program.

What is ICS 213?
The following are excerpts from http://ics.com/

“The ICS 213 General Message Form was originally designed as a multipart self-
copying form for use as an interoffice memo. Since its inception, both the usage
and physical embodiment have changed significantly.

“The ICS 213 General Message Form is now increasingly used for messages
between parties who are not in the same location. Because the nature of incident
communications is generally urgent, the form is often originated in one location and
transmitted electronically to another location. The reply from that location is
returned electronically and the two "parts" of the form are matched together.

GEMERAL MESSAGE
Iro: POSMON:
Fron: POSMON:
CUBJECT: DATE T
iEssAcE:
SIGHATURE: PosmonN
RepLy:
DaTE: e S HATURE/POSMEN:

1S3 213 HFES 1325

Figure 1: Typical ICS-213 Form
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“Because of the General Message Form's increased usage between often physically
distant locations, the information for an ICS 213 General Message Form is often
transcribed onto a blank form or entered electronically via a computer word
processing program.”

1.3 ICS 213 and Outpost

This implementation of ICS 213 Messaging is designed to improve the message
handling efficiency of communications teams who work closely with served
agencies that use the ICS 213 message form.

There are three components of ICS 213 Messaging:

= Ics213mm.exe. This is a standalone program that presents the user with a
computer-based fill-in-the-blank form with fields that align with the ICS 213
message form. It guides the user in creating a message using some pre-defined
message fields values or by direct entry, saving a local copy, and exchanging
messages with Outpost.

i

File Setup Edit Help

[ | Send | Save | Delete| Cloge | Brovze |<<|>>| Edit | Ereply |

Mzgit 1. Locally created message; Draft

 Header
Incident M ame: |City Flanding

Ta |Dan Drreager Fasition: IDps Chief, County OES
From: |Dave Knapp Pasitior: IDES, Cupertino JES
Subiect: |Stevens Creek Dam Status Date: [03/29/2012 20:36

— Meszage

Be advized that the Santa Clara County Y alley ‘water District confirmed that the dam withstood the last ;I
aftershock, but recommends periodic observations of ity downstream face. Cuperting will post volunteer
watches at the parking lot]

=
Signature: |D ave Knapp Positiorn: |DES, Cuperting OES
— Reply
=
[~
Signature Position: I
Diate: |

| Disconnected [20:38:39

Figure 2: The Ics213mm Message form

= Opdirect.exe. Opdirect MCS (Message Capture System) is a program that
listens on the local area network for and receives messages from remote
message sources. Once the message is received, Opdirect processes and writes
the message to the Outpost message database. The Outpost operator then
completes the message and presses Send.

Opdirect MCS listens for, captures, and stores messages from Ics213mm in
Outpost, as well as sending back ICS 213 messages received by Outpost from a
remote station.

9/21/2013 2
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1. Outpost. Outpost continues to be program that interacts with the BBS for
sending and retrieving packet messages.

1.4 An lcs213mm session

Ics213mm helps the user compose a message and get it sent by packet. Here’s what
a user needs to do:

1. At the Outpost computer, verify Opdirect.exe is running. See Section 3.3
Outpost / Opdirect Setup for details.

Run Ics213mm.exe.
Enter a user identifier (you define it, such as BOB, DAVEF, CTYOPS, etc.).
Check the default field settings (optional).

w»ok wn

Press New. The program pre-populates the message form with any default field
settings and opens all message fields for editing.

6. Fill in the subject and the body of the message. When done, press Send.
Ics213mm stores the message locally for retrieving and updating later.

7. At this point, Ics312mm automatically does the following:
Connects and logs on to Opdirect.
b. Formats any outgoing messages into a user-readable text message.

c. Sends the formatted message to Opdirect (which subsequently stores
the message in the Outpost Draft folder).

d. Requests any messages intended for this user ID. Ics213mm stores any
retrieved messages, and then pops up a notification window letting the
user know that an incoming message has arrived.

e. Logs off Opdirect when done.

i
£

mAmAA

50Tl o 1 KNP - W SAOALO0 TELMEY - WS mmm [12en

[ ——
Ics213mm... S't-g;a'e Opdirect... Outpost...

* Lets the user creates an g * Processes logon requests, ¢ The user complete the message
stores messages locally. receives messages, writes by filling in the To: address

* Periodically connects to to Outpost DB, Draft Folder. field.
Opdirect to exchange ICS * Sends Outpost messages * Then, presses Send/Receive.
213 messages with flagged as “ICS213” back to
Outpost. Ics213mm.

Figure 3: lcs213mm Messaging Components
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Why use I¢cs213mm?

*  Keeps the focus on the message — Ics213mm is exclusively aimed at ICS 213
message management: creating, sending, receiving, printing, storing.

*  Reduce transcription errors — Instead of writing a message down on paper and
handing it to a packet operator, the Ics213mm program can be given to the
individuals who need to create the message thereby eliminating the possibility of
interpretation problems and transcription errors.

*  Receives new messages and create replies — Ics213mm can also retrieve
messages that Outpost received thereby closing the loop from message creation
to reply.

*  Deployable anywhere on the same LAN as Outpost — Ics213mm interacts with
Outpost through Opdirect MCS (delivered with Outpost) using standard
networking to interact with Opdirect. As a result, Ics213mm can be deployed
either on the local PC where Outpost is installed, or anywhere on the local area
network.

*  Multiple copies of Ics213mm can be deployed and interact with a single copy of
Outpost. Essentially, Ics213mm can be placed throughout the EOC on the same
LAN as Outpost thereby empowering the users to manage their own message
traffic. Packet radio room operators retain control operator responsibilities since
they complete the message and press Outpost’s Send/Receive button.

Ics213mm Features
Some of the key features of Outpost’s Ics213mm Messaging are:

Message Management

*  Message Types. Ics213mm supports 2 message types: (i) a Message is what the
originator creates, (ii) a Reply is what the recipient sends back. Both the
Message and Reply are linked and managed within a single message structure.
Ics213mm tracks what it is looking at and ensures the right message control
actions are allowed.

*  Message Creation. Ics213mm allows messages to be created from scratch,
importing text from an ASCII file, cut and pasted in from other applications, or
by Replying to a previously received message.

*  Text Message Formatting. Messages can be entered in a free-form text area.
Simple formatting can be performed, errors corrected, and text can be added and
deleted prior to sending the message.

» Storage. All messages and replies are stored locally. This allows the user to
create messages with Ics213mm even if the network or Opdirect is down. Once
up, Ics213mm forwards all pending messages to Outpost.

e Printing. Ics213mm can print a message in the standard ICS 213 format.

* ICS 213 message outside of Outpost. Ics213mm messages sent by Outpost are
formatted in a human-readable and ICS 213-like format for retrieval and use by
non-Outpost users.

Configurations and Setups

e Default fields. Some message fields can be defaulted to predefined values,
particularly if they are the same from message to message. For instance, the
FROM: and FROM POSITION may be set to your name and preloaded at
message creation time.

9/21/2013
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*  Network parameters. Because Ics213mm talks to Opdirect through a network
connection, the user defines the IP address and Port where Opdirect is listening.
Once set, it is always used when Ics213mm runs.

1.7 Notes, assumptions, and disclaimers
= The program attempts to guide the user through the process of creating, sending,
reviewing, retrieving, and printing messages. If you observe obvious problems,
please let me know
=  Error handling will continue to evolve over time. Most of the errors are
properly trapped and reported, however, it is not 100% foolproof.

1.8 Find an Error?

If you find an error or unsure how Outpost’s ICS 213 Messaging is supposed to
work, post a message to the Outpost Users Group or send me email to

kn6pe@arrl.net.

9/21/2013
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2 Getting Started

Al ICS 213 Messaging activities are managed and controlled by the Ics213mm.exe
program. This section provides an overview of the program.

2.1 Introduction
The following are basic concepts to help get you started.

User Identification. Because more than one instance of Ics213mm could be
installed on the LAN, a User ID is stamped on each outgoing message so that the
reply message knows the route back to this user (and copy of Ics213mm).

Message Storage. Ics213mm will locally store messages (independently of
Outpost) that you create, or that are received from Outpost. This allows the user to
start a message or reply, but not send it because of some missing information, as
well as editing a previously sent message thereby creating an update.

Any viewed message can also be printed as desired.

While there may be a tendency to keep messages forever, this is not the intent of
Ics213mm.

Message States. Ics213mm can create a message or reply as well as view a
received message or a received reply. Because of this, it is important to understand
some of the message references that you will see as you work with messages:

Created Message: This is a message that is originated by you and is to be sent
to someone else. You can get to message text area by
pressing New. Only the message area of the form is
enabled for editing.

Received Message:  This is a message received by you that was originated by
someone else. The received message text area is read-only
and cannot be edited.

Created Reply: After you receive a message, you can create a reply to be
sent back to the messages’ originator. After pressing Reply,
the Reply text area of the form is enabled for editing.

Received Reply: This is a copy of your original message and the reply as
created by the person to whom you sent the original
message. The message and reply text areas are read-only
and cannot be edited.

9/21/2013 7
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2.2 The main Ics213mm form

When you start the program, you will see the main window letting you know that
Ics213mm.exe is ready.

=1o]x]
File Setup Edit Help
[ | Send | Save | Deletel Claze | Browse |<<|>>| Edit | Ereply |
—Header
Incident Mame: ||
To: I Position: I
Fraom: | Pasitiar: I
Subject: I Date: |
—Message
Signature: I Positian:
—Reply
[~
-
Sighature I Pozition: I
Diate: |
| Trving to Connect... 20:47:31

2.3 Menus and Toolbars
The Program Controls portion of the User Interface controls the operation and
execution of all program tasks.

B 1c5-213 Messaging [_[o]=]

File Setup Edit Help

Mew | Send | Save | Delete| [Cloze | Browse |<< | >>| Edit | Ereply |

Figure 4: Main Screen Menu and Tool Bar
The Ics233mm menus provide different options for setting up and controlling the
application.

NOTE: Some of the more common menu items are also implemented as Tool Bar buttons.
See the associated menu item below for their description.

Menus Description

File Open: Lets the user pick a text message and load the
message into the Message Area or Reply Area, depending
on the message type.

Save: Saves the message back to the local Ics213mm
message store.

9/21/2013 8
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Menus

Description

Print Setup. Allows the user to select a default printer.

Print. Allows the user to select a printer, and then print
the message in an ICS 213 format.

Exit: Exits the program. If a connection with Opdirect is
in progress, the connection will end first, then the program
will exit.

Setup

Properties: Sets various parameters to control the
behavior of the program:

e Formatting. Allows the user to set up some message
fields as defaults. Additionally, the date and time
format can be specified.

e Remote Access. Sets up the IP address and Port
number for Opdirect. Also, defines the polling
interval that Ics213mm uses to poll for incoming
messages from Outpost.

See Section 3.1 ICS 213 properties for more information.

Identifier: opens a box for entering the User ID.

See Section for more information.

Edit

Cut: Copies and deletes any highlighted text from any
text area of the form. The text is placed in the MS-
Windows clipboard.

Copy: Copies any highlighted text in any from any text
area of the form. The text is placed in the MS-Windows
clipboard.

Paste: Inserts text from the clipboard at the position
where the cursor is located.

Help

About: Lists information about Ics213mm.

The following are other controls found on the main form.

Controls

Description

New

This option is enabled at startup. Sets up Ics213mm for
entering a new message.

Send

This option is enabled whenever you are editing a message
or reply. On pressing Send, the message is saved and
locked, and Ics2 13mm attempts to deliver the message to
Opdirect.

Save

This option is enabled whenever you are editing a message
or reply. On pressing Save, the message is saved and
locked.

9/21/2013
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Controls Description

Delete This option is enabled whenever you are viewing any
message. On pressing Delete, the message is deleted from
the Ics213mm local message store.

Close This option is enabled whenever you are viewing or
editing any message. On pressing Close, the message is
cleared and the New and Browse buttons are enabled.

Browse This option allows the user to Browse the messages found
in the Ics213mm local message store. The number of
messages and the position of the message in the store is
shown to the Right of the buttons.

<< Browse “left”. This option brings up an earlier created
messages for display.

>> Browse “right”. This option brings up a later created
messages for display.

Edit This option is enabled whenever you are browsing
messages. On pressing Edit, you can edit the message text
area of Created Messages or edit the reply text area of
Created Replies.

Pressing this button for sent messages allows you to update
the message thereby letting it be sent again.

Reply This option is enabled only when viewing a Received
Message.

On pressing this option, the status bar will be listed as...
Locally created reply, status is Draft.

Message Status Bar
The message status bar is just below the control buttons. This field describes the
type and state of the message that is currently being displayed.

=I5

File Setup Edit Help

Send | Save | Delete| Close | Browse | 5% | >>| Edit | Beply | [141]

Mzgit 1. Locally created message; Draft

Header
Incident Mame: [City Flooding |

You may see one of these Status line messages:

Status Line Messages Meaning
Locally created message, status is A message that you are creating is not
Draft complete or ready to send. This is

primarily due to a missing field.

9/21/2013
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Status Line Messages

Meaning

Locally created message, status is
Ready/Not Sent

A message that you created. It is ready
to send, but for some reason, has not
been transferred to Opdirect.

Locally created message, status is Sent

A message that you created. It has been
transferred to Opdirect.

Received message, status is Unread

This is a message received by you, and
you are seeing it for the first time.

Received message, status is Read

This is a message received by you, and
you have already read it.

Locally created reply, status is Draft

A reply to someone else’s message that
you are creating. It is not complete or
ready to send

Locally created reply, status is
Ready/Not Sent

A reply that you created. It is ready to
send, but for some reason, has not been
transferred to Opdirect.

Locally created reply, status is Sent

A reply that you created. It has been
transferred to Opdirect.

Received reply, status is Unread

This is a reply sent to you for a message
that you originated, and you are seeing it
for the first time.

Received reply, status is Read

This is a reply sent to you for a message
that you originated, and you have
already read it.

2.5 Message Fields

Field

Description

Incident Name

Name of the incident as assigned by the agency that

activates the event.

Default: Blank, or loaded with the value defined from
Setup > Properties, first tab.

To Name of the individual to whom this message is
intended. This person would be the likely individual to
create the reply.

Default: Blank, or loaded with the value defined from
Setup > Properties, first tab.

(To) Position

The organizational position of the message recipient.

Default: Blank, or loaded with the value defined from
Setup > Properties, first tab.

From

Name of the individual that is originating this message.

Default: Blank, or loaded with the value defined from
Setup > Properties, first tab.

(From) Position

The organizational position of the message author.

Default: Blank, or loaded with the value defined from
Setup > Properties, first tab.

9/21/2013
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Field

Description

Subject

For new messages, enter a subject for this message.

When viewing an existing message, this field contains
the subject of the message. The subject will be used by
Outpost when it sends this as a packet message.

Date

The date that this message is created and sent.

Default: Set with the current date and time based on
the date/time format as defined from Setup >
Properties, first tab.

Message

This is a free-form text field for creating the message to
be sent to the recipient. The message size is limited to
4000 characters.

Default: Blank

Signature

On the standard ICS 213 form, this is the signature of
the individual creating this message.

Default: The content of the From: field is copied here.
However, it can be overridden if necessary.

Position

On the standard ICS 213 form, this is the position of
the individual creating this message.

Default: The content of the From Position: field is
copied here. However, it can be overridden if
necessary.

Reply

This is a free-form text field for creating the reply to
the above message to be sent back to the originator.
The reply size is limited to 4000 characters.

Default: Blank

Signature (Reply)

On the standard ICS 213 form, this is the signature of
the individual replying to this message.

Default: The content of the To: field is copied here.
However, it can be overridden if necessary.

Position (reply)

On the standard ICS 213 form, this is the position of
the individual replying to this message.

Default: The content of the To Position: field is copied
here. However, it can be overridden if necessary.

Date

The date that this reply is created and sent.

Default: Set with the current date and time based on
the date/time format as defined from Setup >
Properties, first tab.

When a message is being edited, Ics213mm unlocks the necessary fields so that they
can be changed. The field text is colored BLACK. When viewing a message that
is not editable, the message text is colored BLUE. This helps the user identify
which fields are changeable depending on whether they are creating or editing a

Message or a Reply.

9/21/2013
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3 Setups

There is a mix of optional and required setups that must be made. This section
describes these setups.

3.1 ICS 213 properties

Program properties cover 3 areas: Message Formatting, and Remote Access.
Access this form from the Setup > Properties menu. There are 2 tabs on this form:

Tabs Description

Message This tab allows you to define some default message field

Formatting values that are automatically loaded whenever you
create a new message. All fields are required.

Remote Access This tab captures the network parameters that Ics213mm

uses to find Opdirect.

Receiving This tab sets up what to do when a message is received.

Tab 1 — Message Formatting

Ics213mm allows you to define some default message field values that are
automatically loaded whenever you create a new message.

x
Farmatting | Remate .-'-‘«cu:essl Receiving |
— Defaults - Hew kMessages
Incident Mame: (TR
I ame Pozition
Ta: IDan Dreager |EI|:|$ Chigf. County OES
Fram IDave F.napp IDES, Cuperting OES
R epart Format
Drate format; Imm,"ddfyyyy
Time Farmat: Ihh:mm
(1] Cancel

Figure 5: Program Properties
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These fields are:

Fields Description

Incident Name of the incident.

Name Default: blank Character size: 64

To: Name Name of the individual to which this message is intended.

This person would be the likely individual to perform any
reply to you.

Default: blank Character size: 64
To: Position The organizational position of the message recipient.
Default: blank Character Size: 64

From: Name  Name of the individual that is originating this message.

Default: blank Character size: 64
From: The organizational position of the message originator.
Position Default: blank Character Size: 64

Date Format The format of the date. This can take many forms,
including:
mm/dd/yy 11/24/09
mm/dd/yyyy 11/24/2009
dd-mmm-yyyy 24-Nov-2009
d-mmm 24-Nov

Default: mm/dd/yy

Time Format  The format of the time. This can take many forms

including:

hh:mm 13:05
h:mm AM/PM  1:05 PM
h:mm:ss 13:05:47

Default: hh:mm

The 2 controls at the bottom of the form apply to both tabs.

Controls Description
OK Saves the settings and closes the form.
Cancel Ignores any changes and closes the form

To make message format setup changes, do the following:

1. Determine the names and positions of the To: and From: individuals that will be
getting these messages. Any field left blank must be filled in at message
creation time.

2. Change the date and time format if necessary. It is recommended that this
format remain the same, or be set to whatever standard format is used.

9/21/2013 14
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3. Press OK when done.
Tab 2 — Remote Access

This tab allows you to configure Ics213mm networking. The goal is to identify
where Ics213mm can find Opdirect on the network.

x

Formatting

— Mezzage Server [Opdirect)

Remote Hast; |12?‘_|:|,|:|_1

Remate Part: Igggq
Metwark Timeout: IEEIEID TNEEE:

Opdirect LinkTest |

Send/Receive [nterval

Check for new messages eveny |B0  seconds [min 30 secs)

(1] Cancel

Figure 6: Remove Access — Finding Opdirect

Ics213mm allows you to define some default message field values that are
automatically loaded whenever you create a new message.

Fields Description

Remote Host  The IP Address or host name of the PC where Opdirect is
running.
The default setting tells Ics213mm to look for the Opdirect
on the PC where Ics213mm is running.

Default: 127.0.0.1

Remote Port  Ports are used with TCP to name the logical connection on a
specific network node. This setting must match what is set
up in the Opdirect Winsock Interface form.

Default: 9334 (DO NOT CHANGE: must match the
Opdirect default port number)

Network The network timeout tells Ics213mm how long to wait for a
Timeout network interaction with Opdirect before giving up and
reporting an error. A setting of 5000 milliseconds
(5 seconds) is plenty, particularly if Opdirect is operating on
the same PC as Ics213mm.

For remote instances of Opdirect, the timeout may need to
be longer depending on the network traffic.

Default: 5000
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Send/Receive Ics213mm will poll Opdirect for any incoming messages at
Interval this interval.

See Section 3.4 Checking the l1cs213mm-Opdirect
connection for a description of how to perform

Default: 60 seconds

This form has one control that can be used to confirm the network setup is set up

correctly.
Controls Description
Opdirect Link  Performs a test network connection with Opdirect.
Test

1. A successful test is indicated by a pop-up box stating
Link test to Opdirect passes

2. An unsuccessful test is indicated by a pop-up box stating

Link test to Opdirect failed. Check the following:
1. Confirm that Host Name and Port number match Opdirect.
2. Confirm that Opdirect is running

Tab 3 — Receiving
This tab lets you configure how Ics213mm will notify you when a message arrives.

x

Farmattingl Femote Access Flecei\-'ingl

—When receiving meszages

[+ Play thiz sound on arival: Iincoming.wav Browse

Qk Cancel

Figure 7: Remove Access — Finding Opdirect
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Operation Description
Play this sound This option allows you to select a .wav file to be played
on arrival when a message is saved in Outpost.

The user can browse for a .wav file, select it, and test it
to confirm that it is suitable for their environment.

See the Play on Arrival Considerations below.

Play on Arrival Considerations

This feature requires that an operational Sound Card is installed in the Outpost PC.
Once you choose a .wav file, pressing the “Test” button will cause the .wav file to
play. If there is a problem with the file or the sound card, a sound card is not
installed or enabled, then Ics213mm will issue a “beep” instead.

While any .wav file can be used or created, two three .wav files are included with
the Outpost distribution as examples for how this feature could be used.

e Sound38.wav — a very obnoxious alarm. If you use this file with the sound
turned up, you will definitely know when a message arrives.

e Soundl136.wav — used for Notifications.

e incoming.wav — a spoken notification. The phrase “Attention, incoming packet
message” is spoken.

User Identification

Multiple copies of Ics213mm could be deployed on the same LAN with all feeding
Outpost via Opdirect. To ensure reply messages get back to the right owner,
Ics213mm “tags” all messages with a routing identifier.

This routing identifier is the same as the User ID. The User ID form is presented
each time Ics213mm runs, as well as from the Setup > Identification menu.

1dentifier x|
E nter your Identifier [i.e.: name, callzign, etc)

Cancel

Figure 8: Set up User Identification

The Identifier must be unique for all Ics213mm’s that connect to a specific instance
of Outpost. No unique Id checking is performed.

This form is has only one field. If there are no changes, just press OK or Enter to
continue.
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e

Fields Description

Identifier When Ics123mm runs on the same PC as Outpost, leave the

Identifier set to LOCAL. For all other PCs running
Ics213mm, pick a different name.

Default: LOCAL

3.3 Outpost / Opdirect Setup

For Ics213mm to complete the message transfer to Outpost, it needs the help of the
Opdirect.exe program.

Opdirect listens on a specific network port for message requests from Ics213mm or
Santa Clara County’s PacFORMS. When a message comes in, Opdirect creates a
valid Outpost message and writes it to the Outpost message database.

Opdirect must be running for Ics213mm to post a message to Outpost. The best
way to do this is to set up Opdirect to run automatically from Outpost.

x

MHew Messagesl Msg Numberingl HepliesanrwardsI Trackingl Deleting ."-‘l.d'v'l

— Meszage Capture Spstem settings

[ Automatically start the Opdirect Message Capture S_I,Jstem
[Restart Dutpost for thiz zetting to take effect] ;

‘When opening a locally onginated PacFORMS mezzage:
& Mever open in its native program
£~ Prompt before opening in its native program
' Always open in its native program

Wwheh opening a received PacFORMS meszage:
f+ Mever open in its native program
" Prompt before opening in its native program
= Always open in its native program

0 Apply Cancel

Figure 9: Running Opdirect from Outpost

1. In Outpost, go to Tools > Message Settings menu, select the Adv Tab.

2. Check the bottom Box to “... Automatically start Opdirect Message Capture
System”. Press OK.

9/21/2013
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3. Exit and restart Outpost. Opdirect will start up, and you will see the following
window open.

i
teszsage kMonitor

Initiahzing Opdirect MCS «2.6 005 ;I

Starting up logging... pazsed!

SEWO0DT: Ready, Listening on Port 9334

[

Feset | Exit |

| SEVO0DT: Server ready

Figure 10: Opdirect Startup Message

The benefit of using this approach is that, on exiting Outpost, Outpost will also
shut down Opdirect as well. To manually start the Opdirect.exe, navigate to the
Outpost directory and double-click on Opdirect.exe.

4. As Opdirect starts up, it will report that it is listening on Port 9334. This is the

default port number that Opdirect, Ics213mm, and PacFORMS uses for passing
message traffic.

Some PCs may have aggressive port blocking turned on and you may be prompted
to Continue Blocking or Unblock. For Opdirect to work, click on Unblock.

There should never be a reason to change the port number that these 3 programs use.
PacFORMS is hard-coded to use this port number. However, if you must change
the port number, then it must be changed for Opdirect and for Ics213mm. The
Opdirect.ini file has an entry that defines the Port Number.

ONLY CHANGE the PortNumiIn value. DO NOT CHANGE ANYTHING ELSE.

[Opdirect MCS]
ConnectNum=302
PortNumIn=9334
Pausev=100

Figure 11: Opdirect.ini file

When you start Outpost, Opdirect will also start up. As you exit Outpost, Opdirect
will be terminated. Outpost is now ready to interact with Ics213mm.

Checking the Ics213mm-Opdirect connection

To verify that Opdirect and Ics213mm are set up correctly, run the Link Test from
Ics213mm.

1. Start Opdirect as described above.

2. Start Ics213mnm if it is not already running. Select Tools > Properties, then
Tab 2 named Remote Access.
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3. Press the Opdirect Link Test button. A short connection test is made with
Opdirect and a pop-up message box indicates the state of the test.

x

Formatting  Remate Access | Receiving |

—Mezzage Server [Opdirect]

Remate Haost: |12?_D_|J_1

Remote Port: |9334
Metwork Timeout: |5E||:||j M3Ec

Opdirect LinkT est il

Send/Receivelnterval — Link Test to Opdirect passed

Check for new messages eveny |3D zeconds

)% | Cancel |

4. [If the test fails, check that the Host Name/IP address and Port Number match
what is set up on Opdirect, and that Opdirect is running.
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4 lcs213mm Messages

Ics213mm relies on Outpost for getting an ICS 213 formatted message sent by
packet to its destination.

*  Ics213mm creates and formats the ICS 213 message.

= The Opdirect program listens for and receives message requests from
Ics213mm, and then writes the message to the Outpost message database.

= The Outpost operator performs the final steps to get the message on its way.

This section describes how to use ICS 213 messaging and what you will se as it
interacts within the rest of the Outpost environment.

4.1 Creating an ICS 213 message
The steps for creating a new ICS 213-based message includes:

1. Configure and start up Outpost and Opdirect (see Section 3.3 Outpost / Opdirect
Setup).

2. Set up any common message field defaults (Setups > Properties).
3. Set or change the Ics213mm User ID (Setups > Identification).

4. Press New to load the message field defaults, set the Signature and Position to
the From/Position fields, and enable the messages fields for editing.

5. Fill in the blank message fields. Since you are creating a Message and not a
Reply, the reply fields are locked and will not take any text input.

=i

File Setup Edit Help

[ En | Send | Save | Delete| Cloge | Erowse |<<|>>| Edit | Reply |

Mgl 1, Locally created message; Draft

—Header
Incident Marne: |Cit_l,l Flaoding

L= an Dieage Pasitior: IDps Chigf, County OES
Frarm: |Dave Knapp Fositian: ID ES, Cupertino OES
Subiect: [Stevens Creek Dam Status Date: f[3/29,/2012 20:45
—Mezsage

Be advized that the Santa Clara County Walley ‘W ater District confirmed that the dam withstood the last ;I
aftershock, but recommends periodic obgervations of its downstream face, Cuperting will post voluntesr
watches at the parking Iot.

[

Signature: |0 ave Knapp Pasitior: |DES, Cuperting OES

rIH = al |

Figure 12: Sample Message

Pressing New, then Save

6. Pressing Save causes Ics213mm to validate that all fields are filled in. If they
are not, the user is prompted whether they want to continue to Save and edit it,
or send it later.
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7. If the user pressing OK, the message is saved, and the fields are locked (colored

BLUE).

Pressing New, then Send

8. Pressing Send causes Ics213mm to perform a Save (see the validation

description above), and then attempts to connect to Opdirect.

9. If Opdirect is running, it loads the message into Outpost and Ics213mm flags the

local message as being sent.

10. If Opdirect is not running, Ics213mm flags the local message as ready, but not

sent.

11. Regardless of whether Opdirect is running, the message is saved, and the fields

are locked (colored BLUE).

Browsing for messages
Because Ics213mm can save messages locally, the Browse function allows you to
review what messages have been created and in what state the messages are in.

Messages are stored in the order in which they were created or loaded. Browsing
lets you step through the list of messages from first to last and select an additional
action to perform on them. Browse can be used as long as there is at least one
message present.

After pressing Browse, the first message is loaded into the message form, is shown
as locked (colored BLUE), and the following actions can be applied to it:

1. Delete. The user can delete the message from Ics213mm. Once deleted, it is
gone.

2. Close. After pressing Close, browsing is ended and the base set of controls is
enabled: New and Browse.

3. << (Browse Left). The previous message in the list is reloaded.
4. >> (Browse Right). The next message in the list is reloaded.
5. Edit. Editing causes all eligible fields to be available for editing. For instance,

a. For a previously saved message that was not completed, the message can
be opened, edited, and completed. The user can press Send to save and
send it.

b. For a previously sent message, the message can be opened and updated
with new information. The user can press Send to save and send this
updated message. NOTE: this overwrites the original local message copy
that was previously sent.

c. For a previously saved reply message that was not completed, the reply
message area can be opened, edited, and completed. Note that the main
message area is still locked (colored BLUE). The user can then press
Send to save and send it.

6. Reply. This option is only enabled when you find a message that was received
from Opdirect. When pressing Reply, The original message area remains
locked (colored BLUE). However, the message reply area is eligible for
editing and updating.

Retrieving sent messages

There is no automated way to retrieve a message you may have accidentally sent
once it is transferred to Outpost. The best you can do is to contact the packet
operator as soon as you discover that the wrong message was sent, and ask him/her
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to delete the message before Outpost posts it to the BBS. If Outpost already posted
the message to the BBS, then the Ics213mm user or Outpost operator should send a
follow-up message requesting that message be ignored or deleted.

Finishing up a Sent message with Outpost

Outpost assumes that any message created and stored in its message database is a
valid message.

One of the side benefits of setting Outpost’s option to run Opdirect on startup
(Tools > Message Settings menu, Advanced Tab) is that, once the message is sent
from Ics213mm, Outpost automatically opens it so that the operator can complete
the packet message.

Ics213mm formats an ASCII message that can be imported by another Outpost and
Ics213mm program as well as read by a non-Outpost / non-Ics213mm user.

¥ cuP267: Stevens Creek Dam Status - Packet Message - o] x|
File Edit Actions Window Help
414

Pint | Send | Save | Delete | Ciose | El Put | Bul | NTs |

Frivate Message

Bhbs: [KEKP-1]

KNEPE

Fromm:

To... |
Subject:

CUP267: Stevens Creek Dam Status

1IC5213!

| v

ICODNAME: City Fleooding

T0: Dan Dreager

POSITION: Ops Chief, County CES

FROM: Dave Enapp

POSITICN: LDES, Cupertino OES

SUBJECT: Stevens Creek Dem Status

DATE: 3/29/2012 9:15:00 EM

MESSAGE: Be advised that the Santa Clara County Valley Water District
confirmed that the dam withstocod the last aftershock, but recommends pericdic
cbservations of its downstream face. Cupertinc will post wolunteer watches at
the parking lot.

SIGNATIURE: Dawve Enapp

POSITICN: LDES, Cupertino OES

ROUTE: LOCAL:1:LOCAL:0

1/IC5213!

Figure 13: Ics213mm message in an Outpost Message form

With the above example, here are some things to note:
= The !ICS213! and !/ICS213! tags begin and end the message.

*  You can add other text either before the '|CS213! tag or after the !/ICS213! tag.
While this text will show up in the Outpost message, it will not show up in the
Ics213mm message.

= DO NOT add any text in between the tags: This will change the content and
possibly the meaning of the message.

To complete the message, the Packet Operator enters the destination address in the
To: field, and then presses Send.

Note the format of the message. Because Outpost sends text messages in the clear,
Ics213mm formats the message so that it is user-readable even if the recipient is not
an Outpost/Ics213mm user.
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5 Message Routing

5.1

5.2

Introduction

Because of the network interconnectivity between Ics213mm and Opdirect,
Ics213mm does not necessarily need to be installed in the radio room. Instead, it
can be installed anywhere on the local area network PROVIDED Ics213mm is on

the same LAN as Outpost.

To get the right message or reply to the right user, Ics213mm needs to perform a
certain amount of message routing, particularly if there is more than one instance of

Ics213mm deployed.

Example of Routing

To help explain routing, let’s assume the following scenario.

River City EOC

Radio Room
Outpost &
lcs213mm

UserlD = LOCAL

Local Area Network

— N — N

P&l Section Logistics Section
lcs213mm lcs213mm

UserID = PNI UserlD = BCOLLINS

Disaster County EOC

Radio Room
Outpost &
lcs213mm

UserlD = LOCAL

At the River City EOC, they have implemented the following:
1.

Local Area Network

———\ ———\
Ops Section Logistics Section
lcs213mm lcs213mm

UserlD = CTYOPS  UserlD = FRED

Disaster County has its’ share of problems and responds whenever a disaster strikes
within its jurisdiction. Most of the problems come from River City which is located

on the Fullbanks River that flows though the county.

In the Radio Room, the Communications Team has a laptop loaded with Outpost

and an instance of Ics213mm. Because this is the ICS 213 central node for their
EOC, they set the User ID to the default “LOCAL”. Their Outpost PC is on the

City” EOC LAN.

2. There are 2 PCs in the EOC. The Planning and Intelligence (P&I) Section has
Ics213mm installed on their PC. This user decided on a User ID of “PNI”.

3.

The other EOC PC is run by the Logistics Section. Bill Collins is the PC user
and decided on an Ics213mm User ID of “BCOLLINS”.

At the Disaster County EOC, they have implemented the following:

1.

In the County Radio Room, the Communications Team also has a PC loaded

with Outpost and an instance of Ics213mm. Because this is the ICS 213 central
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node for the county EOC, they also set the User ID to the default “LOCAL”.
Their Outpost PC is on the County EOC’s LAN.

2. They also have 2 PCs in the EOC. The Operations Section has Ics213mm
installed on their PC, and the PC user decided on a User ID of “CTYOPS”
(abbreviation for County OPS).

3. The other EOC PC is run by the Logistics Section. Fred Jones is the PC user
and decided to set the Ics213mm User ID to “FRED”.

5.3 River City EOC: Sending a Message to County

Today, it’s raining hard in River City and NOAA reports the river will crest late this
afternoon. River City EOC just activated, their Logistics Section needs to send a
message to County Logistics requesting more sand bags.

1. Bill Collins, the River City Logistics Section Chief and PC user, creates the
message in Ics213mm by pressing New, then filling in the Subject and
Message. All other fields were automatically filled in. He then presses Send.

=i

File Setup Edit Help

e | Send | Save | Delete| Cloge | Browse |<<|>>| Edit | Feply |

Msgh 15, Locally created message, status iz Draft

U IF'Ed dones Pasttion: ILogisticS, County EOC
From: |Bill Colline Pasitior: ILogistics, River City
Subisct: [wie've got trouble in River City Date: [11,28/2003 0353
— Meszage
Fred. the Fullbanks River is cresting again, and we need about 200 sandbags. Please confirm that vou ;I
have them, and when you think, you can send them to us)|
Signature: |Bill Calling Positior:  |Logistics, River City
—Reply
|-
Sighature Position: I
Date: |

| | Dizzonnected |E|9: 54:52

2. Bill’s Ies213mm program connects to Opdirect, passes the message to Outpost,
and checks for any incoming messages. Opdirect writes the message to the
Outpost message database, and then tells Outpost that a new outgoing message
is there. Outpost looks for the message and automatically opens it.
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5.4 River City Radio Room: Completing the Message to County

3. The Packet Operator in the radio room sees Bill’s message pop up and fills in
the To: field indicating that this message needs to go to the County EOC (either
the County’s call sign or tactical call).

¥8 r1v276: We've got trouble in River Gity - Packet Messa - O] x|
File Edit Actions Window Help

Prirt | Send | Save | Delete| Cloze | Urgl F'vt| Bul |NTS|

Frivate Message

Bbs |KEKP-1
Fram: |KMEPE

To: [KDBCMY =
Subject: |RIVZTE: Weve gottrouble in River City
11C5213!

I0: Fred Jones

BOSITICHN: Logistics, County EOC
FROM: Bill Cellins

BOSITICN: Logisties, Riwver City

| »

SUBJECT: We'we got trouble in River City

DATE: 11/28/2009 9:55:00 RAM

MESSAGE: Fred, the Fullbanks River is cresting again, and we
need about 200 sandbags. Please confirm that you have them, and
When wyou think you can send them to us.

SIGNATUEE: Bill Collins

POSITICH: Logistics, Riwver City

ROUTE: BCOLLINS:15:LOCAL:0

'/IC5213! LI

4.  When done, the Packet Operator presses Send. Because Outpost is set up to
check the BBS every 5 minutes, the message is automatically sent on its way.

Note the Route line at the bottom of the above message. The format is as
follows:

ROUTE: BCOLLINS:15:LOCAL:O
\ \ \
\ \ \ _ TO: destination at County
\ \ Bill’s local Ics213mm message number
\ FROM: Bill’s User ID

More on this as the scenario unfolds.
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5.5 Disaster County Radio Room: receives the message

5. At the County EOC, Outpost polls the BBS as usual, retrieves this message, and
indicates that the message arrived (some type of audio message or tone is heard).

6. The County packet operator opens the message in Outpost, sees that it is an
ICS 213 message, and it is addressed to Fred Jones, the County Logistics guy.
Because the County packet operator was helping the EOC staff with Ics213mm,
he knows that Fred’s Ics213mm User ID is “FRED”.

With the message open, he selects Actions > Change Route. The sending
station originally set the Destination Route to LOCAL causing the message to

load into the Radio Room’s copy of Ics213mm (who’s User ID is LOCAL).

RIV276: We've got trouble in River City - Packet Messa - | Ellil

File Edit View | Actions Windows Help

Fririt Reply Reply d Delete Elosel
Rieply ba Al

Private Mezzage Farward

Bhs: KBKP- Sent: 11/28/2009 0359

From: KMNEPE

Subject: RIVZT7E: We've gottrouble in
Change Intemal Houting...%

11C5213!

TQ: Fred Jones
POSITION: Logistics, County EC

FROM: Bill Collins

POSITION: Logistics, Riwver Cite
SUBJECTI: We'we got trouble in River City

DATE: 11/28/2009 9:55:00 M

MESSAGE: Fred, the Fullkanks River is cresting again, and we need
gbout 200 sandbags. Please confirm that vou have them, and when
vou think you can send them to us.

SIGHNATURE: Bill Cellins

POSITION: Logistics, Riwver City

ROUTE: BCOLLINS:15:LOCAL:O

1/1C5213

[

7. The County packet operator changes the Route to match what Fred set up on his
Ics213mm, which is, “FRED?”, presses OK, and then presses Close to close the

message.

Change Route x|

Change Intermal Bouting...

Cancel | :

JFRED
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5.6 Disaster County EOC: receiving the message

8. Shortly thereafter, Fred’s Ics213mm program automatically polls Outpost for
any incoming messages with a routing for “FRED”, and finds one. At Fred’s
PC, Ics213mm pops up the notification letting him know that a message arrived.

i

File Setup Edit Help

New I Send | S awe I Dﬁla}ﬁl [lrze I Rrowze | <o | >>| Edit | Heply |

I
New incaming MESSAGE... =]

FROM:  Bill Coling
SIUBJECT: ‘we've aot trouble in River City
DATE:  11/28/2003 3.55:00 Ak

Press Open to view the message or Cloze to skip. LI

Open | ["Einse

9. Fred presses Open, and the message is loaded for him to review. This what he
sees...

i

File Setup Edit Help

MHew | Send | Save | Delete| [Cloze | Browse |<< | >>| Edit | Reply |

Mag 17, Recieved message, status iz Mew

Te: IFred Jones Position: ILogistics, County EOC
From: |Bi|| Callirg Pasitian: ILogistics, River City
Subizct [ywie've got trouble in River City Date: [11,/26,2009 09:55
— Meszage
Fred, the Fullbanks River is cresting again, and we need about 200 andbags. Please confirm that pou d
hawe them, and when vou think pou can zend them to us,
Signature: |Bill Calling Pasition: |Logistics, River City
— Reply
Signature Pozition; I
Date: [12/30/1833 00:00
| IC5-213 Message Maker Ready | Dizconnected |10:18:20

Some things to note:
= The Message status is listed as Received message, status is New.
=  The message is listed in BLUE meaning that it is currently READ ONLY.

= Because this is an incoming message, the only actions allowed are to DELETE
or REPLY.
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=  Fred wants to print this; he uses the menu File > Print so his team can see if
they can meet he request. Fred prints 2 copies (not shown here).

5.7 Disaster County EOC: Replies to the message

10. County has 1000 sandbags that they can deliver. Fred presses Reply and fills in

the Reply section of the message letting Bill know that they can be there in 3
hours.

=l

File Setup Edit Help

e | Send | Save | Delete| Cloze | Browse |<<|>>| Edit | Heply |

Mzght 17, Locally created reply, status is Draft

Te: IFred Jones Fosition: ILogistics, County EOC
From: |gill Colir: Position: |Logistm Riiver Cily
Subiect: [we've got ouble in River City Diate: [11,28/200 03.55
—Message

Fred, the Fullbanks River is cresting again, and we need about 200 sandbags. Please confirm that wou d
hawe them, and when vou think pou can zend them to us,

[ |

Signature: IBiII Calling Pasition: |Logistics, River City

— Reply

Bill, Courty has 1000 zandbags in reserve. We will deliver 200 zandbags to River City, usual location, ﬂ
by 1:00PM today) T

-]

Signature IFred Jones Position: ILogistics, County EOC

Date: [17/28/2009 1023

| | Dizconnected |'I 0:24:28

Note that the original message text area remains locked (BLUE) while the reply text
area is open for editing (BLACK). The reply signature, position, and date that the
reply was created are automatically filled in.

11. When done, Fred presses Send and the reply is sent back to the County Outpost
system.

=I5

File Setup Edit Help

Mew | Send | Save | Delete| Cloze | Browse |<<|>>| Edit | Heply |

Mzght 17, Locally created reply, status iz Sent

[c: IF'Ed dones Positian: ILogisticS, County EOC
Frorn: |Bill Collin Posiion: [Togistcs. River City
Subject fuseve aot rouble in River City Date: [11,28/2009 0355

The message status is now updated to Locally created reply, status is Sent.
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5.8 Disaster County Radio Room: Complete the reply
12. Back in County’s Radio Room, the reply message pops up and the County
packet operator completes the message by filling in the To: field.

13. When done, the County packet operator presses Send and Outpost sends it to
the BBS.

=0l x|

File Edit Actions Window Help

Frirt | Send ‘ Save | Delele| Cloze | Ulgl F'vt‘ BuI|NTS|

Frivate Meszage

Bbs: |KEKP-1

From: |KDECKV

Ta: |KMEPE :I
Subject: |SSF277: We've gottrouble in River City

'IC5213! s
T0: Fred Jones

POSITION: Logistics, County EOC

FROM: Bill Cocllins

POSITION: Logistics, Riwver City

SUBJECT: We'we got trouble in Riwver City

DATE: 11/2&/2009 9:55:00 RM

MESSAGE: Fred, the Fullbanks River 13 cresting again, and we
need about 200 sandbags. FPlease confirm that yvou have them, and
when you think you can send them to us.

SIGNATURE: Bill Collins

POSITION: Logistics, Riwer City

REPLY: Bill, County has 1000 sandbags in reserve. We will
deliver 200 sandbags to River City, usual location, by 1:00FM
today.

SIGNATURE: Fred Jones

POSITION: Logistics, County EOC

RDRTE: 11/28/2009 10:27:00 &M

ROUTE: FRED:17:BCOLLINS:13S
'/IC5213! LI

Note the Route. It shows it is from “FRED” and to “BCOLLINS”. This ensures
that the reply gets back to the originator without any packet operator intervention.
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5.9 River City Radio Room: Receives the reply message

14. River City’s Outpost retrieves the message. As described above, because the
route is set to BCOLLINS, there is no need for any interaction with the message.

5.10 River City EOC: Receives the reply message

15. Finally, Bill Collins’ Ics213mm automatically polls Outpost for any messages

and retrieves the reply from County. The program opens a notification window
letting the PC operator know that a reply message has been received.

¥ 1cs 213 Messaging =0 x|

File Setup Edit Help

o] 55| edv | Aepy |
Mew incoming REPLY... ﬂ
FROM: FredJaones

SUBJECT: “We've got trouble in River City
DATE:  11/28/2009 9:55:00 Ak

Prezs Open to view the message or Cloze to skip. LI

Open |

-
16. Bill presses Open and sees his original message, plus Fred’s reply.
il

File Setup Edit Help

Mew | Send | Save | Delete| Close | Browse |<<| >>| Edit | Freply |
Megit 19, FRecieved reply, status iz Mew

To: IFred Jones

Pasition: ILogistics, County EOC

From: |Bi|| Callins Pasition: ILogistics,Hiver City

Stbieet fie've got trauble in River City Date: |11,/28/2009 09:55

—Meszage

Fred. the Fullbanks River is cresting again, and we need about 200 sandbags. Flease confim that you ;I
hawve them. and when wou think you can send them to us.

[

Signature: |Bill Collin: Positior: | Laogistics, Fiver City

— Reply

Bill, County haz 1000 zandbags in reserve. We vall deliver 200 zandbags to River City, usual location, ;I
by 1:00PH today.

[~

Signature  |Fred Jones Position: ILogistics, County EOC

Diate: [17/26/2008 10:27

| IC5-213 Meszage Maker Ready | Dizconnected |1 4:47:33

Note that the message status is Received reply, status is New. Because this
completes the entire exchange, the message cannot be edited. If a new message is
needed, the user presses New and creates a new message.
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